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Design Exploration Tutorial

This tutorial introduces HDL Designer Series. It shows how to use it in design exploration and
visualization.
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Welcome to HDL Designer Series
This tutorial shows how HDL Designer Series can be used to add a design described by VHDL
or Verilog HDL text and visualize the design structure as a hierarchy of graphical design unit
views. The graphical views can be printed or exported as HTML files for use in design
documentation.

This tutorial can be performed by users of HDL Designer Series or by users of HDL Designer
which incorporates all the features supported by HDL Designer Series.

The Design Manager
The design manager is opened when the HDL Designer Series tool is invoked for the first time.

If the examples project is not active, it can be opened by choosing Project from the Open
cascade of the File menu to display the Open Project dialog.
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The procedures in this tutorial use the SCRATCH_LIB library defined in the examples project
although you can use any other empty writable library.

Add the Fibonacci Design
1. In the Design Manager window select Existing Design from the Add cascade of the

File menu to display the Add Existing Design wizard.

2. Specify the method to add your design by selecting Copy Specified Files from the left
most section.Choose VHDL Files (if you are using VHDL) or Verilog Files (if you are
using Verilog) from the Show Files of Type pulldown filter. In the Folders pane locate
the Fibonacci sequencer design source code in the examples sub-directory of your
installation. For example, if HDS is installed in the directory D:\LatestBuild, the path is:

D:\LatestBuild\examples\tutorial_ref\Import\Sequencer
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3. Click OK to display the Target Libraries page of the Add Existing Design wizard.

The Target Libraries page allows you to specify the library used for the added design
when no library is explicitly specified in the source HDL. You can also change the
library used for views added from one or more of the source files.

4. Choose the SCRATCH_LIB library and click the Next button to display the Target
Directories page.

This page allows you to view or edit directory names used by the added files when you
are adding HDL from a directory hierarchy.
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5. Click the Finish button on the Target Directories page to complete the HDL adding.

The SCRATCH_LIB library is automatically opened in a new design explorer window.

The HDL Log Window shows the progress of the add operation and the following
summary report is displayed on completion:

HDL Import complete
--------------------------------------------------------

3 files imported to 1 library

--------------------------------------------------------

Browse the Fibonacci Design
1. Examine the design in the design explorer Design Units pane using the  icons to

expand each design unit.

The following picture shows the added VHDL design:
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Each Verilog module or VHDL entity in the source HDL code is partitioned into a
separate design unit which also includes the corresponding VHDL architectures if you
are using VHDL.

Notice that a  icon is displayed adjacent to the fibgen_tb design unit in the Design
Units pane. This test bench component is marked as the top level design unit.

Both Verilog and VHDL designs are shown in the design explorer with the Design
Units, Files and Design Hierarchy panes.

If the Design Hierarchy pane is not visible, select the fibgen_tb design unit and use the
Right mouse button to select Show Hierarchy from the popup menu.

Note
You can toggle the hierarchy for any object by choosing Hide Hierarchy or Show
Hierarchy from the popup menu.
You can also add or remove objects in the Design Hierarchy pane by dragging and
dropping with the Left mouse button.

2. Examine the design in the Design Hierarchy pane using the  icons to expand each
view.

The Design Hierarchy pane shows how each Verilog module or VHDL architecture is
instantiated as a HDL text view in the hierarchy.

The test bench (fibgen_tb) contains the fibgen design unit instantiated as the unit under
test (UUT) and also the fibgen_tester instantiated as the Checker.

The UUT hierarchy contains the control design unit (instantiated as FSM) and three
instantiations (acc_A, acc_B and acc_sum) of the accumulator.



Design Exploration Tutorial, V2008.1b10

Design Exploration Tutorial
Create a Block Diagram View

May 1, 2009

Create a Block Diagram View
1. Select the module view (if you are using Verilog) or the architecture view (if you are

using VHDL) of the fibgen design unit in the Design Units pane of the design explorer.

2. Use the right mouse button to choose Single Level from the Convert To Graphics
cascade in the popup menu (or use the Convert HDL to Graphics button) to display the
View Styles page of the Convert To Graphics wizard:

3. Select the Block Diagram option for hierarchy descriptions and use the Finish button to
convert the HDL text view to a graphical block diagram.

The HDL Log Window displays a summary report on completion:

Convert To Graphics complete
--------------------------------------------------------

1 HDS design unit saved,
1 component

1 block diagram

--------------------------------------------------------
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Notice that the icon used for the default fibgen view in the design explorer changes to
 indicating that it has been converted to a block diagram view.

4. Double-click to open the block diagram which should look similar to the following
picture:

The block diagram shows the four components (acc_A, acc_B, acc_sum and FSM) with
the signals connected between them and an embedded block (eb1) containing concurrent
assignment statements. All signal nets are connected by default.

Note
If you move the cursor over any object, a popup graphic tip is displayed showing
information about the object.
For example, the port name and the connected net name are shown when the cursor is
over a component port.
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The block diagram is completed by a default title block.

You can open down into the HDL describing each component or embedded block by
double-clicking over the instance on the diagram or by selecting the instance and
choosing the view from the Open As or Open cascade of the popup menu.

Notice that the printer page boundaries for your default printer are shown by dotted lines
on the diagram with the origin at the top left corner of the window. You can change the
page layout and set options for page boundaries by choosing Page Setup from the File
menu to display the Page Setup dialog box.

The Layout tab allows you to modify the page layout so that the diagram prints on a
single page. For example by setting the Adjust to option to print at 75% of normal size
or by setting the Fit to option to a specified number of pages.

The Boundaries tab allows you to set options for how page boundaries are displayed
and printed. Use the Help buttons on each tab to display a full description of the options
available in this dialog box.

The page boundaries on the diagram are automatically updated when you change the
page setup or you can choose Refresh Page Boundaries from the File menu to update
them after changing the diagram.

HDL Designer Series allows you to make logical edits which would change the HDL
description for a graphic editor view. However, you can make non-logical edits to
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prepare a diagram for printing or export. If you have made any non-logical edits, you are
prompted to save when you close the graphic editor view.

For example, you can move or resize objects, change the grid, port or signal text
visibility, and edit the comment text in the title block.

5. Re-size the diagram to fit in a single printer page boundary:

Note
You can make all text associated with an object visible by choosing Show Text from the
popup menu or hide an individual text element by choosing Hide Text.

Refer to the HDL Designer Series Graphical Editors User Manual for more information
about editing the diagram layout and changing the visibility of text objects.

Print the Diagram
You can print an entire diagram view or the extent of the current window by choosing Print or
Print Window from the File menu.

Note also that the Print dialog box includes an option to print selected pages or you can choose
Print Page from the popup menu to print the area within the current page boundaries.

Add Panels to the Block Diagram
1. Use the Add Panel button (or choose Panel from the Add menu) to add a panel

(Panel0) on the diagram. Hold down the Left mouse button and drag the panel around
the graphical objects on the diagram releasing the button when the panel encloses the
required area. Click the Right mouse button to deselect the panel tool.

2. Click the Right mouse button in an empty part of the diagram to display the popup
menu and choose Object Visibility to display the Object Visibility Settings dialog box.
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3. Select the Declarations option and choose OK.

4. Drag this text to an empty part of the diagram by dragging the Declarations label. (You
cannot move this object by dragging the individual declaration statements.)

Note
You can select text objects only by using the  on the  and choosing Select Text
from the drop down menu.

5. Use the Add Panel button (or choose Panel from the Add menu) and drag a new panel
(Panel1) around the signal declarations.

The signal declarations are now displayed in a separate panel from the graphical
diagram layout and can be printed or exported separately by specifying the panel name.

For example, the Print dialog box contains an option to select a named panel for
printing.

Object Linking and Embedding
On a Windows workstation, you can use Object Linking and Embedding (OLE) to drag a
complete or partial graphic editor view directly on to a documentation tool such as Microsoft
Word or Adobe FrameMaker.
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This can be done by pressing the Right mouse button over the blue border on the left edge of a
diagram to display a popup menu and choosing Set Drag All or Set Drag Panel <panel
name>.

The diagram or panel can then be imported directly into the documentation tool by dragging the
blue border using the Left mouse button. A diagram included in this way can be opened from
within the documentation tool by simply double-clicking on the picture to invoke the HDL
Designer Series tool.

Display the IBD View
1. Use Edit as IBD button or choose Edit as IBD from the Diagram menu in the block

diagram to open an alternative editor view which displays the interfaces and connections
as a tabular Interface-Based Design view. You are prompted to save the block diagram
prior to opening the IBD view (if it is not already saved).

Notice that each of the four components and the embedded block are shown as separate
columns in the IBD view matrix.

A separate column (E in the example below) shows the external interface for the design
unit.
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The rows in the matrix contain the signal declarations and interconnections are shown
by the letter I (Input) or O (Output) in the interconnect cell for the external interface,
embedded block or component interface. You can expand the interface column to
display the connected ports for a component as shown for the acc_A instance above by
clicking on the  icon.

Note
Refer to the IBD View Notation section in the HDL Designer Series Graphical Editors
User Manual for information about how more complex port mapping is represented in an
IBD view.
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Display the Symbol
1. Click the Open Up button in the block diagram or IBD view window to display the

symbol interface as a tabular IO view in a new window.

2. Display the symbol by selecting Symbol in the Structure Navigator pane.

3. Close the symbol/Interface, IBD view/Block diagram windows saving any non-logical
edits.
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Create a State Diagram View
1. Select the module view (if you are using Verilog) or the architecture view (if you are

using VHDL) of the control design unit in the Design Units pane in the design explorer.

2. Use the Right mouse button to choose Single Level from the Convert To Graphics
cascade in the popup menu (or use the Convert HDL to Graphics button) to display the
View Styles page of the Convert to Graphics wizard.

3. Select the State Diagram option for leaf-level descriptions and use the Finish button to
convert the HDL text view to a graphical state diagram.

The HDL Log Window displays a summary report on completion:

Convert To Graphics complete
--------------------------------------------------------

1 HDS design unit saved,
1 component

1 state machine

--------------------------------------------------------

Notice that the icon used for the FSM instance changes to indicating that it has been
converted to a state diagram view.
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4. Double-click to open the state diagram which should look similar to the following
picture:

Note
You can zoom in, zoom out or view all of the state diagram using the Zoom In, Zoom
Out or View All buttons.

This simple state machine comprises a start state (clr_regs) and three simple states
(inc_accb, load_acc_sum and load_acc_A_B) connected by transitions.

You can move or resize objects, add panels and edit the title block or make any other
non-logical edits which would not change the logical definition of the state machine.

Notice that there is a deliberate signal assignment error in the actions specified for the
clr_regs and inc_accb states. To show the actions choose Show Text from the state
popup menu.

HDL Designer Series allows you to correct these errors by changing the logical
definition and the original source code to view the corrected state diagram.
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Relevel the State Diagram
The example used in this tutorial comprises only four states but state machines recovered from
real designs may have many states. In these cases, it can be useful to break the initial flat state
diagram into one or more hierarchical diagrams.

1. Select the inc_accb, load_acc_sum and load_acc_A_B states by holding down the Shift
key as you select the three states.

2. Choose Add Hierarchy from the Re-level cascade in the Diagram or popup menu.
Notice that the selected states are replaced by a hierarchical state (s0).

The selected states have been moved into a new child hierarchical state diagram. The
child diagram is saved as part of the same design unit view and is logically identical to
the original flat diagram.

3. Double-click the hierarchical state (s0) to open the child hierarchical state view.

You can remove state machine hierarchy by selecting the hierarchical state and choosing
Remove Hierarchy from the Re-level cascade in the Diagram or popup menu. This
operation brings all states in the child diagram up a level into the parent diagram.

Windows users can print or insert any hierarchical state diagram into a design document
using OLE in the same way to that previously described for block diagrams.

You can also add a title block and comment text, comment graphics or panels to any
diagram in the hierarchy.
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For example, a title block and a panel have been added to the following child state
diagram view:

4. Close the child and parent state diagrams saving any non-logical edits.

Create a Flow Chart View
Any HDL text view can be optionally recovered as a flow chart. The alternative flow chart
option is set by default when you set the state diagram HDL convert option (in the Add Existing
Design wizard) and any HDL text view which is not recognized as a state machine is
automatically converted to a flow chart.

1. Select the accumulator design unit in the design explorer and use the Convert HDL to
Graphics button.

2. Select the Flow Chart check box in the Leaf Level Descriptions pane of the Convert to
Graphics Wizard and click Finish.

The new flow chart is added to the accumulator component in the design explorer,
represented by the  icon.
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3. Double-click to open the chart which should look similar to the following picture:

Note
If you are using Verilog, the decision box for the clock event is not present.

Notice how the HDL code is represented by a number of separate action boxes with
conditional statements represented by decision boxes. A more complex design may also
include case boxes, loops and wait boxes.

Windows users can print or insert a flow chart into a design document using OLE in the
same way to that previously described for block diagrams and state diagrams. You can
also add a title block and comment text, comment graphics or panels.

4. Close the flow chart saving any non-logical edits.
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Visualizing your HDL Designs
You have now added HDL code to HDS, converted it to block diagram, IBD, state diagram and
flow chart views. You can also visualize your HDL text views by transforming your source
code into graphical views known as visualization views. Only non-logical edits can be
performed on the resulting graphical views. That is to say, you can make layout modifications
and save them, yet you cannot perform logical edits that would reflect on the source code;
however, any changes in the source HDL view can be easily updated in the visualization view.

1. Select the fibgen_tb design unit in the design explorer and use the Document And
Visualize drop-down palette in the toolbar or choose Document and Visualize from the
File menu. Choose the Document and Visualize through Components option. The
Document and Visualize dialog box is displayed.
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2. Click the Options button to display the Documentation and Visualization Options
dialog box. Check that Block Diagram, Flow Chart and Open diagram after
visualization options are selected and click OK.

3. On the Document and Visualize dialog click OK to proceed with your visualization. A
progress indicator is displayed showing the advancement of the visualization process,
and then a message is raised informing you of the location of the visualization views;
click OK.
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Note
If a graphical view already exists for the design object you wish to visualize, you will not
be able to create a visualization view having the same name as that of the graphical view.
In this case, a message is raised informing you that graphical views having the same
name already exist and to replace these graphical views, you have to set the option
“Overwrite Existing Views” in the Documentation and Visualization dialog box.
Nevertheless, if you do not wish to override the existing graphical views, you can rename
them before running the visualization process.

4. Consequently, a window is opened showing the top-level of the fibgen_tb design unit
visualized as a block diagram.
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5. To view the source code of the visualization click on the Open HDL Source button in
the toolbar of the visualization window. The DesignPad editor displays the current top-
level design only.

6. In the Files pane of the Design Manager window expand the Visualization folder of the
Documentation and Visualization node to explore the rendered visualized views.

On double-clicking on any of the visualized child views, a graphical editor window is
opened to display the HDL visualized.



Design Exploration Tutorial
Export the Design Hierarchy as HTML

Design Exploration Tutorial, V2008.1b 27
May 1, 2009

Note
If you make changes in the source HDL view, the overlay is displayed on the
visualization view indicating that it is out-of-date. You can easily update your
visualizations through the popup menu.

Refer to the “Documentation and Visualization” chapter in the HDL Designer Series User
Manual for more information about visualizing HDL text views.

Export the Design Hierarchy as HTML
You can print any of these views or you can export any view (or hierarchy of views) in HTML
format as a fully browsable web site.

1. Select the fibgen_tb design unit in the design explorer and use the Document And
Visualize Design button or choose Document and Visualize from the File menu to
display the Document and Visualize dialog box. Choose the Document and Visualize
through Components option.

2. Choose the Create a Website (Export HTML) option.

3. Click the Options button to display the Documentation and Visualization Options
dialog box.

4. In the Website Options tab, set the depth of the Hierarchy Levels to Descend as All.

All Include options should be left set for this tutorial although these can be used to
exclude specific view types. (For example, you might unset all options except Block
Diagram or IBD when you only want to export structural views.)
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5. In the Graphics Settings tab, set the Graphics Format as JPEG.

6. Click the OK button to confirm the Documentation and Visualization Options dialog
box.

7. In the Document and Visualize dialog box, enter (or use the Browse button to browse
for) the location of the export target directory (for example, D:\Temp\ExportHTML) and
click the OK button to confirm the Document and Visualize dialog box.

All other options should be left with their default settings. The export operation is
monitored in the HDL Log Window ending with a summary report:

The design has been exported to the directory
D:\Temp\ExportHTML
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To view the HTML load the following file into your Browser.
SCRATCH_LIBfibgen_tbindex.htm
Export HTML complete.

View the Exported HTML Hierarchy
1. Your default web browser is automatically launched displaying the index file

SCRATCH_LIBfibgen_tbindex.htm file. The exported HTML tree appears in the Files
pane of your design explorer. The exported HTML is displayed in two frames:

o The Navigation frame shows the design hierarchy and can be expanded or collapsed
in a similar way to the HDL Designer design explorer by clicking on the and
icons or by using the Expand All and Collapse All buttons.

o The Design frame shows the graphical or HDL text view corresponding to the object
selected in the Navigation frame. You can also use the tabs to display additional
information including side data and generated HDL.

For example, the following Internet Explorer browser shows the expanded fibgen_tb
hierarchy and the Fibgen block diagram displayed in the Design frame.
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When you have exported hierarchical views, hyperlinks are created on the parent
diagram (for example, blocks and components on a block diagram or hierarchical states
on a state diagram).

You can open down into the child views by clicking on these hotspots to display the
corresponding HTML page. Alternatively, you can use the Open Up button to move up
through the design hierarchy.

Note
The Open Up button moves up through the design hierarchy displayed in the Navigation
frame. For a component, the parent view is displayed unlike in a graphic editor when the
symbol is displayed.

You can zoom in, zoom out or view all using the Zoom In, Zoom Out or View Normal
buttons and navigate to the previous or next view using the Back or Forward buttons.

You can use the Information tab to display text information such as generation settings,
local declarations, compiler directives or package references. Additional tabs allow you
to display side data and generated HDL if these have been also exported.

Export the Design Library as HTML
You can also export HTML for an entire library. This option allows you to export HTML for all
design unit views in a library including symbols, non-default views and any views of design
units which have no explicit hierarchical relationship.

1. Select the SCRATCH_LIB library in the design explorer the design explorer and use the
 button or choose Document and Visualize from the File menu to display the

Document and Visualize dialog box.

2. Follow steps 2 to 7 in the previous section (Export the Design Hierarchy as HTML).
When you confirm the dialog box, HTML is exported for each design unit in the library.

View the Exported HTML Library
1. View the exported library by opening the HTML index file SCRATCH_LIBindex.htm

file from the HTML directory in the Files explorer pane.

Any of these views can be displayed in the Navigation frame and browsed in a similar
way to the exported hierarchy.
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For example, the following Internet Explorer browser shows the contents of the
SCRATCH_LIB library with the control state machine shown in the Design frame:

Refer to the “Printing Views” and the “Documentation and Visualization” chapters in the HDL
Designer Series User Manual for more information about printing and exporting graphical
views.

You have now completed the Design Exploration Tutorial.
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End-User License Agreement
The latest version of the End-User License Agreement is available on-line at:

www.mentor.com/terms_conditions/enduser.cfm

END-USER LICENSE AGREEMENT (“Agreement”)

This is a legal agreement concerning the use of Software (as defined in Section 2) between the company acquiring
the license (“Customer”), and the Mentor Graphics entity that issued the corresponding quotation or, if no
quotation was issued, the applicable local Mentor Graphics entity (“Mentor Graphics”). Except for license
agreements related to the subject matter of this license agreement which are physically signed by Customer and an
authorized representative of Mentor Graphics, this Agreement and the applicable quotation contain the parties'
entire understanding relating to the subject matter and supersede all prior or contemporaneous agreements. If
Customer does not agree to these terms and conditions, promptly return or, if received electronically, certify
destruction of Software and all accompanying items within five days after receipt of Software and receive a full
refund of any license fee paid.

1. ORDERS, FEES AND PAYMENT.

1.1. To the extent Customer (or if and as agreed by Mentor Graphics, Customer’s appointed third party buying agent) places and
Mentor Graphics accepts purchase orders pursuant to this Agreement (“Order(s)”), each Order will constitute a contract
between Customer and Mentor Graphics, which shall be governed solely and exclusively by the terms and conditions of this
Agreement, any applicable addenda and the applicable quotation, whether or not these documents are referenced on the
Order. Any additional or conflicting terms and conditions appearing on an Order will not be effective unless agreed in
writing by an authorized representative of Customer and Mentor Graphics.

1.2. Amounts invoiced will be paid, in the currency specified on the applicable invoice, within 30 days from the date of such
invoice. Any past due invoices will be subject to the imposition of interest charges in the amount of one and one-half
percent per month or the applicable legal rate currently in effect, whichever is lower. Prices do not include freight,
insurance, customs duties, taxes or other similar charges, which Mentor Graphics will invoice separately. Unless provided
with a certificate of exemption, Mentor Graphics will invoice Customer for all applicable taxes. Customer will make all
payments free and clear of, and without reduction for, any withholding or other taxes; any such taxes imposed on payments
by Customer hereunder will be Customer’s sole responsibility. Notwithstanding anything to the contrary, if Customer
appoints a third party to place purchase orders and/or make payments on Customer’s behalf, Customer shall be liable for
payment under such orders in the event of default by the third party.

1.3. All products are delivered FCA factory (Incoterms 2000) except Software delivered electronically, which shall be deemed
delivered when made available to Customer for download. Mentor Graphics retains a security interest in all products
delivered under this Agreement, to secure payment of the purchase price of such products, and Customer agrees to sign any
documents that Mentor Graphics determines to be necessary or convenient for use in filing or perfecting such security
interest. Mentor Graphics’ delivery of Software by electronic means is subject to Customer’s provision of both a primary
and an alternate e-mail address.

2. GRANT OF LICENSE. The software installed, downloaded, or otherwise acquired by Customer under this Agreement,
including any updates, modifications, revisions, copies, documentation and design data (“Software”) are copyrighted, trade
secret and confidential information of Mentor Graphics or its licensors, who maintain exclusive title to all Software and retain
all rights not expressly granted by this Agreement. Mentor Graphics grants to Customer, subject to payment of applicable
license fees, a nontransferable, nonexclusive license to use Software solely: (a) in machine-readable, object-code form; (b) for
Customer’s internal business purposes; (c) for the term; and (d) on the computer hardware and at the site authorized by Mentor
Graphics. A site is restricted to a one-half mile (800 meter) radius. Customer may have Software temporarily used by an
employee for telecommuting purposes from locations other than a Customer office, such as the employee's residence, an airport
or hotel, provided that such employee's primary place of employment is the site where the Software is authorized for use.
Mentor Graphics’ standard policies and programs, which vary depending on Software, license fees paid or services purchased,
apply to the following: (a) relocation of Software; (b) use of Software, which may be limited, for example, to execution of a
single session by a single user on the authorized hardware or for a restricted period of time (such limitations may be technically
implemented through the use of authorization codes or similar devices); and (c) support services provided, including eligibility
to receive telephone support, updates, modifications, and revisions. For the avoidance of doubt, if Customer requests any change
or enhancement to Software, whether in the course of receiving support or consulting services, evaluating Software or

 IMPORTANT INFORMATION

USE OF THIS SOFTWARE IS SUBJECT TO LICENSE RESTRICTIONS. CAREFULLY READ THIS
LICENSE AGREEMENT BEFORE USING THE SOFTWARE. USE OF SOFTWARE INDICATES YOUR
COMPLETE AND UNCONDITIONAL ACCEPTANCE OF THE TERMS AND CONDITIONS SET FORTH

IN THIS AGREEMENT. ANY ADDITIONAL OR DIFFERENT PURCHASE ORDER TERMS AND
CONDITIONS SHALL NOT APPLY.

http://www.mentor.com/terms_conditions/enduser.cfm


otherwise, any inventions, product improvements, modifications or developments made by Mentor Graphics (at Mentor
Graphics’ sole discretion) will be the exclusive property of Mentor Graphics.

3. ESC SOFTWARE. If Customer purchases a license to use development or prototyping tools of Mentor Graphics’ Embedded
Software Channel (“ESC”), Mentor Graphics grants to Customer a nontransferable, nonexclusive license to reproduce and
distribute executable files created using ESC compilers, including the ESC run-time libraries distributed with ESC C and C++
compiler Software that are linked into a composite program as an integral part of Customer’s compiled computer program,
provided that Customer distributes these files only in conjunction with Customer’s compiled computer program. Mentor
Graphics does NOT grant Customer any right to duplicate, incorporate or embed copies of Mentor Graphics’ real-time operating
systems or other embedded software products into Customer’s products or applications without first signing or otherwise
agreeing to a separate agreement with Mentor Graphics for such purpose.

4. BETA CODE.

4.1. Portions or all of certain Software may contain code for experimental testing and evaluation (“Beta Code”), which may not
be used without Mentor Graphics’ explicit authorization. Upon Mentor Graphics’ authorization, Mentor Graphics grants to
Customer a temporary, nontransferable, nonexclusive license for experimental use to test and evaluate the Beta Code
without charge for a limited period of time specified by Mentor Graphics. This grant and Customer’s use of the Beta Code
shall not be construed as marketing or offering to sell a license to the Beta Code, which Mentor Graphics may choose not to
release commercially in any form.

4.2. If Mentor Graphics authorizes Customer to use the Beta Code, Customer agrees to evaluate and test the Beta Code under
normal conditions as directed by Mentor Graphics. Customer will contact Mentor Graphics periodically during Customer’s
use of the Beta Code to discuss any malfunctions or suggested improvements. Upon completion of Customer’s evaluation
and testing, Customer will send to Mentor Graphics a written evaluation of the Beta Code, including its strengths,
weaknesses and recommended improvements.

4.3. Customer agrees that any written evaluations and all inventions, product improvements, modifications or developments that
Mentor Graphics conceived or made during or subsequent to this Agreement, including those based partly or wholly on
Customer’s feedback, will be the exclusive property of Mentor Graphics. Mentor Graphics will have exclusive rights, title
and interest in all such property. The provisions of this Subsection 4.3 shall survive termination of this Agreement.

5. RESTRICTIONS ON USE.

5.1. Customer may copy Software only as reasonably necessary to support the authorized use. Each copy must include all
notices and legends embedded in Software and affixed to its medium and container as received from Mentor Graphics. All
copies shall remain the property of Mentor Graphics or its licensors. Customer shall maintain a record of the number and
primary location of all copies of Software, including copies merged with other software, and shall make those records
available to Mentor Graphics upon request. Customer shall not make Software available in any form to any person other
than Customer’s employees and on-site contractors, excluding Mentor Graphics competitors, whose job performance
requires access and who are under obligations of confidentiality. Customer shall take appropriate action to protect the
confidentiality of Software and ensure that any person permitted access does not disclose or use it except as permitted by
this Agreement. Log files, data files, rule files and script files generated by or for the Software (collectively “Files”)
constitute and/or include confidential information of Mentor Graphics. Customer may share Files with third parties
excluding Mentor Graphics competitors provided that the confidentiality of such Files is protected by written agreement at
least as well as Customer protects other information of a similar nature or importance, but in any case with at least
reasonable care. Standard Verification Rule Format (“SVRF”) and Tcl Verification Format (“TVF”) mean Mentor
Graphics’ proprietary syntaxes for expressing process rules. Customer may use Files containing SVRF or TVF only
with Mentor Graphics products. Under no circumstances shall Customer use Software or allow its use for the purpose of
developing, enhancing or marketing any product that is in any way competitive with Software, or disclose to any third party
the results of, or information pertaining to, any benchmark. Except as otherwise permitted for purposes of interoperability
as specified by applicable and mandatory local law, Customer shall not reverse-assemble, reverse-compile, reverse-
engineer or in any way derive from Software any source code.

5.2. Customer may not sublicense, assign or otherwise transfer Software, this Agreement or the rights under it, whether by
operation of law or otherwise (“attempted transfer”), without Mentor Graphics’ prior written consent and payment of
Mentor Graphics’ then-current applicable transfer charges. Any attempted transfer without Mentor Graphics’ prior written
consent shall be a material breach of this Agreement and may, at Mentor Graphics’ option, result in the immediate
termination of the Agreement and licenses granted under this Agreement. The terms of this Agreement, including without
limitation the licensing and assignment provisions, shall be binding upon Customer’s permitted successors in interest and
assigns.

5.3. The provisions of this Section 5 shall survive the termination of this Agreement.

6. SUPPORT SERVICES. To the extent Customer purchases support services for Software, Mentor Graphics will provide
Customer with available updates and technical support for the Software which are made generally available by Mentor Graphics
as part of such services in accordance with Mentor Graphics’ then current End-User Software Support Terms located at
http://supportnet.mentor.com/about/legal/.

http://supportnet.mentor.com/about/legal/


7. LIMITED WARRANTY.

7.1. Mentor Graphics warrants that during the warranty period its standard, generally supported Software, when properly
installed, will substantially conform to the functional specifications set forth in the applicable user manual. Mentor
Graphics does not warrant that Software will meet Customer’s requirements or that operation of Software will be
uninterrupted or error free. The warranty period is 90 days starting on the 15th day after delivery or upon installation,
whichever first occurs. Customer must notify Mentor Graphics in writing of any nonconformity within the warranty period.
For the avoidance of doubt, this warranty applies only to the initial shipment of Software under the applicable Order and
does not renew or reset, by way of example, with the delivery of (a) Software updates or (b) authorization codes or alternate
Software under a transaction involving Software re-mix. This warranty shall not be valid if Software has been subject to
misuse, unauthorized modification or improper installation. MENTOR GRAPHICS’ ENTIRE LIABILITY AND
CUSTOMER’S EXCLUSIVE REMEDY SHALL BE, AT MENTOR GRAPHICS’ OPTION, EITHER (A) REFUND OF
THE PRICE PAID UPON RETURN OF SOFTWARE TO MENTOR GRAPHICS OR (B) MODIFICATION OR
REPLACEMENT OF SOFTWARE THAT DOES NOT MEET THIS LIMITED WARRANTY, PROVIDED
CUSTOMER HAS OTHERWISE COMPLIED WITH THIS AGREEMENT. MENTOR GRAPHICS MAKES NO
WARRANTIES WITH RESPECT TO: (A) SERVICES; (B) SOFTWARE WHICH IS LICENSED AT NO COST; OR (C)
BETA CODE; ALL OF WHICH ARE PROVIDED “AS IS.”

7.2. THE WARRANTIES SET FORTH IN THIS SECTION 7 ARE EXCLUSIVE. NEITHER MENTOR GRAPHICS NOR
ITS LICENSORS MAKE ANY OTHER WARRANTIES EXPRESS, IMPLIED OR STATUTORY, WITH RESPECT TO
SOFTWARE OR OTHER MATERIAL PROVIDED UNDER THIS AGREEMENT. MENTOR GRAPHICS AND ITS
LICENSORS SPECIFICALLY DISCLAIM ALL IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR
A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF INTELLECTUAL PROPERTY.

8. LIMITATION OF LIABILITY. EXCEPT WHERE THIS EXCLUSION OR RESTRICTION OF LIABILITY WOULD BE
VOID OR INEFFECTIVE UNDER APPLICABLE LAW, IN NO EVENT SHALL MENTOR GRAPHICS OR ITS
LICENSORS BE LIABLE FOR INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES (INCLUDING
LOST PROFITS OR SAVINGS) WHETHER BASED ON CONTRACT, TORT OR ANY OTHER LEGAL THEORY, EVEN
IF MENTOR GRAPHICS OR ITS LICENSORS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN
NO EVENT SHALL MENTOR GRAPHICS’ OR ITS LICENSORS’ LIABILITY UNDER THIS AGREEMENT EXCEED
THE AMOUNT PAID BY CUSTOMER FOR THE SOFTWARE OR SERVICE GIVING RISE TO THE CLAIM. IN THE
CASE WHERE NO AMOUNT WAS PAID, MENTOR GRAPHICS AND ITS LICENSORS SHALL HAVE NO LIABILITY
FOR ANY DAMAGES WHATSOEVER. THE PROVISIONS OF THIS SECTION 8 SHALL SURVIVE THE
TERMINATION OF THIS AGREEMENT.

9. LIFE ENDANGERING APPLICATIONS. NEITHER MENTOR GRAPHICS NOR ITS LICENSORS SHALL BE LIABLE
FOR ANY DAMAGES RESULTING FROM OR IN CONNECTION WITH THE USE OF SOFTWARE IN ANY
APPLICATION WHERE THE FAILURE OR INACCURACY OF THE SOFTWARE MIGHT RESULT IN DEATH OR
PERSONAL INJURY. THE PROVISIONS OF THIS SECTION 9 SHALL SURVIVE THE TERMINATION OF THIS
AGREEMENT.

10. INDEMNIFICATION. CUSTOMER AGREES TO INDEMNIFY AND HOLD HARMLESS MENTOR GRAPHICS AND
ITS LICENSORS FROM ANY CLAIMS, LOSS, COST, DAMAGE, EXPENSE OR LIABILITY, INCLUDING
ATTORNEYS’ FEES, ARISING OUT OF OR IN CONNECTION WITH CUSTOMER’S USE OF SOFTWARE AS
DESCRIBED IN SECTION 9. THE PROVISIONS OF THIS SECTION 10 SHALL SURVIVE THE TERMINATION OF
THIS AGREEMENT.

11. INFRINGEMENT.

11.1. Mentor Graphics will defend or settle, at its option and expense, any action brought against Customer in the United States,
Canada, Japan, or member state of the European Union which alleges that any standard, generally supported Software
product infringes a patent or copyright or misappropriates a trade secret in such jurisdiction. Mentor Graphics will pay any
costs and damages finally awarded against Customer that are attributable to the action. Customer understands and agrees
that as conditions to Mentor Graphics’ obligations under this section Customer must: (a) notify Mentor Graphics promptly
in writing of the action; (b) provide Mentor Graphics all reasonable information and assistance to settle or defend the
action; and (c) grant Mentor Graphics sole authority and control of the defense or settlement of the action.

11.2. If a claim is made under Subsection 11.1 Mentor Graphics may, at its option and expense, (a) replace or modify Software so
that it becomes noninfringing, or (b) procure for Customer the right to continue using Software, or (c) require the return of
Software and refund to Customer any license fee paid, less a reasonable allowance for use.

11.3. Mentor Graphics has no liability to Customer if the claim is based upon: (a) the combination of Software with any product
not furnished by Mentor Graphics; (b) the modification of Software other than by Mentor Graphics; (c) the use of other than
a current unaltered release of Software; (d) the use of Software as part of an infringing process; (e) a product that Customer
makes, uses, or sells; (f) any Beta Code; (g) any Software provided by Mentor Graphics’ licensors who do not provide such
indemnification to Mentor Graphics’ customers; or (h) infringement by Customer that is deemed willful. In the case of (h),
Customer shall reimburse Mentor Graphics for its reasonable attorney fees and other costs related to the action.

11.4. THIS SECTION IS SUBJECT TO SECTION 8 ABOVE AND STATES THE ENTIRE LIABILITY OF MENTOR
GRAPHICS AND ITS LICENSORS AND CUSTOMER’S SOLE AND EXCLUSIVE REMEDY WITH RESPECT TO
ANY ALLEGED PATENT OR COPYRIGHT INFRINGEMENT OR TRADE SECRET MISAPPROPRIATION BY
ANY SOFTWARE LICENSED UNDER THIS AGREEMENT.



12. TERM.

12.1. This Agreement remains effective until expiration or termination. This Agreement will immediately terminate upon notice
if you exceed the scope of license granted or otherwise fail to comply with the provisions of Sections 2, 3, or 5. For any
other material breach under this Agreement, Mentor Graphics may terminate this Agreement upon 30 days written notice if
you are in material breach and fail to cure such breach within the 30 day notice period. If a Software license was provided
for limited term use, such license will automatically terminate at the end of the authorized term.

12.2. Mentor Graphics may terminate this Agreement immediately upon notice in the event Customer is insolvent or subject to a
petition for (a) the appointment of an administrator, receiver or similar appointee; or (b) winding up, dissolution or
bankruptcy.

12.3. Upon termination of this Agreement or any Software license under this Agreement, Customer shall ensure that all use of the
affected Software ceases, and shall return it to Mentor Graphics or certify its deletion and destruction, including all copies,
to Mentor Graphics’ reasonable satisfaction.

12.4. Termination of this Agreement or any Software license granted hereunder will not affect Customer’s obligation to pay for
products shipped or licenses granted prior to the termination, which amounts shall immediately be payable at the date of
termination.

13. EXPORT. Software is subject to regulation by local laws and United States government agencies, which prohibit export or
diversion of certain products, information about the products, and direct products of the products to certain countries and certain
persons. Customer agrees that it will not export Software or a direct product of Software in any manner without first obtaining
all necessary approval from appropriate local and United States government agencies.

14. U.S. GOVERNMENT LICENSE RIGHTS. Software was developed entirely at private expense. All Software is commercial
computer software within the meaning of the applicable acquisition regulations. Accordingly, pursuant to US FAR 48 CFR
12.212 and DFAR 48 CFR 227.7202, use, duplication and disclosure of the Software by or for the U.S. Government or a U.S.
Government subcontractor is subject solely to the terms and conditions set forth in this Agreement, except for provisions which
are contrary to applicable mandatory federal laws.

15. THIRD PARTY BENEFICIARY. Mentor Graphics Corporation, Mentor Graphics (Ireland) Limited, Microsoft Corporation
and other licensors may be third party beneficiaries of this Agreement with the right to enforce the obligations set forth herein.

16. REVIEW OF LICENSE USAGE. Customer will monitor the access to and use of Software. With prior written notice and
during Customer’s normal business hours, Mentor Graphics may engage an internationally recognized accounting firm to
review Customer’s software monitoring system and records deemed relevant by the internationally recognized accounting firm
to confirm Customer’s compliance with the terms of this Agreement or U.S. or other local export laws. Such review may include
FLEXlm or FLEXnet (or successor product) report log files that Customer shall capture and provide at Mentor Graphics’
request. Customer shall make records available in electronic format and shall fully cooperate with data gathering to support the
license review. Mentor Graphics shall bear the expense of any such review unless a material non-compliance is revealed. Mentor
Graphics shall treat as confidential information all information gained as a result of any request or review and shall only use or
disclose such information as required by law or to enforce its rights under this Agreement. The provisions of this section shall
survive the termination of this Agreement.

17. CONTROLLING LAW, JURISDICTION AND DISPUTE RESOLUTION. The owners of the Mentor Graphics intellectual
property rights licensed under this Agreement are located in Ireland and the United States. To promote consistency around the
world, disputes shall be resolved as follows: This Agreement shall be governed by and construed under the laws of the State of
Oregon, USA, if Customer is located in North or South America, and the laws of Ireland if Customer is located outside of North
or South America. All disputes arising out of or in relation to this Agreement shall be submitted to the exclusive jurisdiction of
Portland, Oregon when the laws of Oregon apply, or Dublin, Ireland when the laws of Ireland apply. Notwithstanding the
foregoing, all disputes in Asia (except for Japan) arising out of or in relation to this Agreement shall be resolved by arbitration in
Singapore before a single arbitrator to be appointed by the Chairman of the Singapore International Arbitration Centre (“SIAC”)
to be conducted in the English language, in accordance with the Arbitration Rules of the SIAC in effect at the time of the
dispute, which rules are deemed to be incorporated by reference in this section. This section shall not restrict Mentor Graphics’
right to bring an action against Customer in the jurisdiction where Customer’s place of business is located. The United Nations
Convention on Contracts for the International Sale of Goods does not apply to this Agreement.

18. SEVERABILITY. If any provision of this Agreement is held by a court of competent jurisdiction to be void, invalid,
unenforceable or illegal, such provision shall be severed from this Agreement and the remaining provisions will remain in full
force and effect.

19. MISCELLANEOUS. This Agreement contains the parties’ entire understanding relating to its subject matter and supersedes all
prior or contemporaneous agreements, including but not limited to any purchase order terms and conditions. Some Software
may contain code distributed under a third party license agreement that may provide additional rights to Customer. Please see
the applicable Software documentation for details. This Agreement may only be modified in writing by authorized
representatives of the parties. All notices required or authorized under this Agreement must be in writing and shall be sent to the
person who signs this Agreement, at the address specified below. Waiver of terms or excuse of breach must be in writing and
shall not constitute subsequent consent, waiver or excuse.
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